Experiment HM-11: Electromyograms (EMG) for Paired Arm Wrestling

Background
The movement of parts of the body is accomplished through a system of levers composed of skeletal muscles and bones. In a lever, the muscle attached to the bone provides the effort or force that moves the bone. As the muscle contracts and relaxes, flexes or extends, the bone rotates around a joint in the skeletal system. In relation to the muscles, the bones, and the body part being moved, the joint is the fixed point that functions as the fulcrum for the lever. The body part being moved is the load in the lever (Figure HM-11-B1).

![Image of a lever system](image-url)

**Figure HM-11-B1**: A Third Class lever and a counterpart in the human body. The insertion of the muscle on the bone in the forearm places the effort between the elbow (fulcrum) and the hand (load).

All levers, including the ones in the body, can be categorized into one of three classes, which are based on the position of the fulcrum in relation to the positions of the effort and the load.

In First Class levers, the fulcrum is between the effort and the load, like on a see-saw. In the body, an example of this class is the extension of the forearm by the triceps muscle.

In Second Class levers, the load is between the effort and the fulcrum, like a wheel barrow. In the body, an example of this class is standing on tiptoe by using the gastrocnemius muscle.

In Third Class levers, the effort is between the fulcrum and the load, like tweezers. In the body, an example is the flexion of the forearm by the biceps muscle.

Arm Wrestling and EMG Activity
Studying electromyograms (EMGs), the electrical impulses occurring within certain muscles when active or inactive, is an interesting way to study the physiology of muscle activity and the lever idea of how arm movement works. Commonly, looking at antagonistic muscle pairs, such as the biceps and triceps, while flexing and extending has been the norm. This allows looking at how the EMG activity changes based on what muscle is in use. However, there are other ways to observe EMG activity, and have an interactive, more interesting time doing it. Looking at any activity that involves flexing and extending pairs of muscles can be used, arms are easily accessible...so, would you like to be better at arm wrestling?
Arm wrestling involves the primary use of four muscles: Biceps brachii, Pronator teres, Pectoralis major and Flexor carpi ulnaris. Other muscles such as the Deltoid, Latissimus dorsi and Triceps brachii are also used. The forearm muscles are generally thought to be the most important with the upper arm and chest providing strength as well.

The basic idea of arm wrestling is to pin your opponent's arm to the table. The general rules of arm wrestling are simple:

- Contestants should start square to the table with at least one foot on the ground.
- Your body should not touch your hand at all.
- Contestants should not allow their body, aside from their hand, to cross to the other side of the table.
- To win, you must cause your opponent's hands or fingers to touch the table’s surface.

As the arm wrestling contestants begin the competition, EMGs are generated to keep their muscles active and move their forearms to pin the opponent to the table. The muscles that become active will depend on whether the contestant is winning, gaining the advantage by pushing their opponent’s arm to the table; or losing, being at a disadvantage when their arm is being pushed towards the table. In either case, the muscles are working to push against the other individual’s muscles.

In this lab, students will use arm wrestling to observe and measure EMG activity while winning and losing at a wrestling match. Electrodes will be placed on the Biceps brachii (upper arm) and Pronator teres (forearm) and Deltoid (shoulder) muscles to observe muscle action as different forces are used to pin their opponent to the table.

As an additional set of exercises, the electrodes can be moved to any of the sets of muscles used in arm wrestling to gain an understanding of how these muscles function while winning or losing a match. Some suggestions include:

- Pectoralis major, Deltoid and Biceps brachii (You may see cardiac rhythms when the electrodes are on the pectoralis muscle. These will be overshadowed by the EMG activity during the match.)
- Pronator teres, Triceps brachii and Biceps brachii
- Pronator teres, Biceps brachii and Flexor carpi ulnaris
- Deltoid, Pectoralis major and Pronator teres
- Any combination of three muscles listed above

**Experiment HM-11: Electromyogram (EMG) for Paired Arm Wrestling**

**Equipment Required**

- PC Computer
- IXTA data acquisition unit
- USB cable
- IXTA power supply

*Human Muscle – EMG-PairedArmWrestling – Background*
2 - iWire-B3G EMG cable and electrode lead wires
Disposable electrodes (14)
Alcohol swabs
Flat table
Rubber mat or towel to protect elbows

**IXTA Setup**

1. Place the IXTA on the bench, close to the computer.
2. Check Figure T-1-1 in the Tutorial Chapter for the location of the USB port and the power socket on the IXTA.
3. Check Figure T-1-2 in the Tutorial Chapter for a picture of the IXTA power supply.
4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA.
5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the power supply cable into the socket on the rear of the IXTA. Use the power switch to turn on the unit. Confirm that the power light is on.

**Start the Software**

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is not available, click on the Windows Start menu, move the cursor to All Programs and then to the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window will appear as the program opens.
2. On the Main window, pull down the Settings menu and select Load Group.
3. Locate the folder that contains the settings group, IPLMv6Complete.iwxgrp. Select this group and click Open.
5. After a short time, LabScribe will appear on the computer screen as configured by the EMG-PairedArmWrestling settings.
6. For your information, the settings used to configure the LabScribe software and the IXTA unit for this experiment are programmed on the Preferences Dialog window which can be viewed by selecting Preferences from the Edit menu on the LabScribe Main window.
7. Once the settings file has been loaded, click the **Experiment** button on the toolbar to open any of the following documents:
   - Appendix
   - Background
   - Labs
   - Setup (opens automatically)
EMG Cable Setup

1. Locate the 2 - iWire-B3G EMG cables and electrode lead wires (**Figure HM-11-S1**) in the iWorx kit.

2. Insert the connector on the end of the iWire-B3G - EMG cable into the iWire 1 input on the front of the IXTA (**Figure HM-11-S3**). Repeat this procedure for the 2nd iWire, plugging it into the iWire 2 input.

**Note - Connect the iWire-B3G prior to turning on the IXTA.**

3. Locate the muscles of the forearm, upper arm and shoulder over which the recording electrodes will be placed. Muscles can be located by flexing or extending the hand and noting the areas of the forearm where the muscles are tense during these hand positions:

- One pair of recording electrodes will be placed over the Pronator teres muscle on the anterior surface of the forearm. The pair of electrodes should be placed side by side, with 2-4 centimeters between them, on the length of the muscle as it crosses the inner forearm (**Figure HM-11-S2**).
- A second pair of electrodes will be placed over the Biceps brachii on the upper arm. The first electrode in this pair will be placed about 4 centimeters above the elbow. The second electrode in this pair will be placed about 2-4 centimeters above the first, towards the shoulder.
- A third pair of electrodes will be placed over the Deltoid on the shoulder. The first electrode in this pair will be placed on the front side of the Deltoid, near the anterior part of the head of the humerus. The second electrode in this pair will be placed on the back of the Deltoid, even with the one in the front.
- A seventh electrode, used as the ground, is placed on the arm, between the Biceps brachii and the Deltoid.
4. Use an alcohol swab to clean and scrub the areas where the electrodes will be placed (Figure HM-11-S4). Let the areas dry before attaching the electrodes.

5. Remove the plastic disk from a disposable electrode and apply it to one of the scrubbed areas. Attach an electrode to each of the other areas.

6. Snap the recording lead wires onto the electrodes, so that:
   - the red “+1” lead is attached to the electrode on the anterior forearm on the Pronator teres, close to the lateral edge of the arm towards the thumb.
   - the black “-1” lead is attached to the electrode on the anterior forearm on the Pronator teres, closest to the middle of the forearm, near the elbow.
   - the white “+2” lead is attached to the electrode on the anterior upper arm on the Biceps brachii, near the elbow.
   - the brown “-2” lead is attached to the electrode on the anterior upper arm on the Biceps brachii, above the +2 electrode.
• the blue “+3” lead is attached to the electrode on the shoulder on the anterior portion of the Deltoid.

• the yellow “-3” lead is attached to the electrode on the shoulder on the posterior portion of the Deltoid, opposite the +3 electrode.

• the green “C” lead (the ground) is attached to the electrode on the arm between the Pronator teres and Biceps muscles.

Note: When you are using two iWire-B3G units – both participants will be tested at once.

Figure HM-11-S4: Position of electrodes used to record EMG from muscles in the forearm & shoulder during arm wrestling. Note: the yellow electrode is on the posterior side of the Deltoid and cannot be seen in this image.

Experiment HM-11: Electromyograms (EMG) for Paired Arm Wrestling

Exercise 1: EMGs During “Simulated” Arm Wrestling

Aim: To study the EMG activity in muscles that work while simulating winning or losing during arm wrestling.

Note: Only one of the participants will have the electrodes attached to his/her arm.
Procedure

1. Instruct the subject that he or she will be doing the following during this exercise:

   • Before the recording begins, the subjects will get into correct arm wrestling position with an opponent. The arms should be roughly perpendicular to the table top. This position is defined as the neutral position (Figure HM-11-L1).
   • Place a rubber mat or towel under the elbows of the participants.
   • Slowly move his or her arm, while flexion of the muscles occurs, from the neutral position while pushing the opponent’s hand towards the table top (Winning). Do not go farther than half way. Hold this position for four seconds and then relax.
   • Return the hand to the neutral position for four seconds.
   • Slowly have the opponent move his or her arm, while flexion of the muscles occurs, from the neutral position pushing the subject’s hands back past the neutral position to half way towards the table top (Losing). Hold this position for four seconds and then relax.
   • Return the hand to the neutral position for at least two seconds.
   • Repeat this cycle two more times while recording.

Note: This is NOT the actual arm wrestling match. Do not use all your effort while performing this activity. This is to show the EMG activity that will occur while either losing or winning an actual match.

Note: Marks will be made for Opponent 1

2. Before the starting the recording, type Neutral in the Mark box to the right of the Mark button. Instruct the subject to place his or her arm in the neutral position, while clasping the hand of the opponent.
3. Click the Record button in the upper right corner of the LabScribe Main window. Click on the Mark button to label the recording.
4. While the subject’s arm is in the neutral position, type Winning in the Mark box. When the subject pushes his or her opponent’s arm towards the table, click on the Mark button to label the
recording.

5. While the subject’s arm is in this position, type Neutral in the Mark box. When the subject returns his or her arm to the neutral position, click on the Mark button to label the recording.

6. While the subject’s arm is back in the neutral position, type Losing in the Mark box. When the subject’s arm is pushed towards the table by the opponent, click on the Mark button to label the recording.

7. Repeat Steps 2 through 6 two more times.

8. When the last cycle is completed, click the Stop button.

9. Click AutoScale on both channels to amplify signals. The recording should be similar to Figure HM-11-L2.

10. Select Save As in the File menu, type a name for the file. Choose a destination on the computer in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click on the Save button to save the data file.

Figure HM-11-L2: Recordings from Pronator teres, Biceps brachii and Deltoid muscles of the arm during simulated arm wrestling showing both opponents.

Data Analysis

1. Scroll through the recording and find the section of data recorded while the subject was simulating arm wrestling.

2. Use the Display Time icons to adjust the Display Time of the Main window so all three cycles appear on the Main window. The three cycles can also be selected by:
   - Placing the cursors on either side of the three adjacent cycles; and
   - Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment with the three cycles to the width of the Main window.
3. Click on the Analysis window icon in the LabScribe toolbar (Figure HM-7-L3) or select Analysis from the Windows menu to transfer the data displayed in the Main window to the Analysis window (Figure HM-7-L4).

![Figure HM-7-L3: The LabScribe toolbar.]

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis window. The mathematical functions, Abs. Int and T2-T1 should appear in this table. The values for Abs. Int and T2-T1 on each channel are seen in the table across the top margin of each channel.

5. Once the cursors are placed in the correct positions for measuring the parameters of an EMG burst, the values for the parameters can be recorded in the on-line notebook of LabScribe by typing the names and values directly into the Journal, or on a data table.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter the names and values of the parameters to the Journal. To use these functions:
   - Place the cursors at the locations used to measure the absolute integrals.
   - Transfer the name of the mathematical function used to determine these values to the Journal using the Add Title to Journal function in the Pronator teres Channel pull-down menu.
   - Transfer the values for the absolute integrals to the Journal using the Add All Data to Journal function in the Pronator teres Channel pull-down menu.
Figure HM-11-L4: EMG activity from arm muscles. Cursors are placed to measure the EMG activity taking place simultaneously in the 3 muscles while Opponent 1 is “winning” at arm wrestling; Opponent 2 is “losing”. Note - only one “win-lose” cycle is shown.

7. Use the mouse to click on and drag the cursors to the onset and offset of the EMG burst during the first “winning” cycle (Figure HM-11-L4). The values for Abs. Int and T2-T1 on the Pronator teres channel are the relative amounts of the EMG activity and the durations of the EMG burst in the Pronator teres muscle while “winning” at arm wrestling. The values for these parameters, listed in the table above the Deltoid and Biceps brachii channels, are the same properties from this muscle during the same time period.

8. Record the values from each muscle group during the first flexion in the Journal, or on a data table.

9. Use the mouse to move the cursors to onset and offset of the next EMG burst while the subject was “losing” at arm wrestling. Measure and record the values for Abs. Int and T2-T1 from both muscles while “losing”.

10. Measure the Abs.Int and T2-T1 for the EMG bursts from the three muscles from the remaining two cycles.

11. Average the values for the Abs.Int. and T2-T1 of the three muscles while “winning” and “losing” occurred during the simulated arm wrestling match. Enter the averages for each parameter, from each muscle group during winning and during losing, on Table HM-11-L1.

12. Select Save from the File menu.
**Questions**

1. Which muscles, Pronator, Deltoid or Biceps, had the most EMG activity during winning?
2. Which muscles, Pronator, Deltoid or Biceps, had the most EMG activity during losing?
3. Does flexion or extension of the individual muscles affect the strength of EMG activity in either muscles?
4. Can the subject feel a difference when winning or losing a match? Is there a correlation between what the subject “feels” and what is seen for the amount of EMG activity?

**Exercise 2: EMGs During an Actual Arm Wrestling Match**

**Aim:** To study the EMG activity in muscles that work while winning or losing during an actual arm wrestling match.

**Note:** Only one of the participants will have the electrodes attached to his/her arm.

**Procedure**

1. Use the same experimental setup used in Exercise 1.
2. Instruct the subjects to rest his or her forearm, with the electrodes, on a flat surface. Place a towel or mat under the elbows of the participants.
3. Have the participants clasp hands and get ready to arm wrestle.

**Note:** The person operating the computer needs to observe the subjects carefully to notice when the subject’s arm moves from a winning position to a losing position and back again. This can occur relatively quickly, and some matches can be over in less than a minute. REMEMBER – marks are made for Opponent 1 only.

4. Click Record. Instruct the subjects to begin arm wrestling at any time after the Record button has been clicked. Mark the recording “Start Wrestling”.
5. Record the EMG activity from the muscles of the arm while the subject is winning or losing during the arm wrestling match. Mark the recording appropriately when the subject’s arm changes from a winning or losing position (Figure HM-11-L5).
6. The match is over when the subject either pins his opponent’s arm to the table or gets pinned by his/her opponent.
7. When the match is over, click Stop to halt the recording.
8. Select Save in the File menu.

Data Analysis
1. Scroll through the recording and find the section of data recorded while the subject was arm wrestling his/her opponent.
2. Use the same procedures used in Exercise 1 to measure and record the Abs. Int and T2-T1 from each muscle while winning or losing the match.
3. Average the values for each parameter taken from the two different muscles while wrestling. Enter the means for each parameter, from each muscle during the match, on Table HM-11-L1.
4. Select Save from the File menu.

Questions
1. Does the strength of the EMG activity in the muscles differ during a simulated match compared to an actual competition?

Figure HM-11-L5: Recording of an actual arm wrestling match between equally matched opponents.
2. Which muscle is more active during:
   - winning?
   - losing?

3. Ask both participants where they felt the most muscle activity during particular times of the match. Were some muscles more active than others when winning or losing?

4. Were muscles other than the ones tested being engaged?

5. How does the action of an individual muscle, such as the Pronator teres, the Biceps brachii, the Deltoid, or any other muscle involved, have an effect on how the arm moves during an arm wrestling competition?

**Table HM-7-L1: Relative EMG Activity in the Muscles of the Forearm during Flexion and Extension.**

<table>
<thead>
<tr>
<th>Forearm Action</th>
<th>Averages during Simulated Arm Wrestling</th>
<th>Averages during Actual Arm Wrestling Match</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Abs.Int</td>
<td>T2-T1 (sec)</td>
</tr>
<tr>
<td>Pronator teres - Winning</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Biceps brachii - Winning</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deltoid - Winning</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pronator teres - Losing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Biceps brachii - Losing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deltoid - Losing</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Exercise 3: EMGs During an Actual Arm Wrestling Match using Other Muscle Groups

Aim: To study the EMG activity in other muscles that work while winning or losing during an actual arm wrestling match.

1. Choose two different participants for this exercise, so that no one is fatigued from competing in Exercise 2.
2. Use an alcohol swab to clean and scrub the areas where the electrodes will be placed. Let the areas dry before attaching the electrodes.
3. Remove the plastic disk from a disposable electrode and apply it to one of the scrubbed areas.
4. Snap the recording lead wires onto the electrodes, so that:
   - the red “+1” lead is placed on the electrode on the first muscle to be tested. The general location should be on the “belly” of the muscle where the muscle will be most active during a match.
   - the black “-1” lead is placed on the electrode approximately 2-4 centimeters away from the red “+1” electrode on the same muscle.
   - the white “+2” lead is attached to the electrode on the second muscle to be tested. The general location should be on the “belly” of the muscle where the muscle will be most active during a match.
   - the brown “-2” lead is attached to the electrode approximately 2-4 centimeters away from the white “+2” electrode on the same muscle.
   - the blue “+3” lead is attached to the electrode on the second muscle to be tested. The general location should be on the “belly” of the muscle where the muscle will be most active during a match.
   - the yellow “-3” lead is attached to the electrode approximately 2-4 centimeters away from the blue “+3” electrode on the same muscle.
   - the green “C” lead (the ground) is attached to the electrode midway between two sets of these electrodes.
5. Repeat the Recording and Data Analysis procedures from Exercise 2 for the new muscles selected.
6. Answer questions 1 through 3 from Exercise 2 for the new muscles being tested.